New York State Office of General Services
Business Services Center
Empire State Plaza
Albany, NY 12242
(Phone) 518-457-4272
(Fax) 518-486-9166

Modifying an Expense Report After it Has Been Denied

An Expense Report (ER) may be denied and returned to you for more information or alteration. The BSC recommends
you check the status of your expense reports weekly to ensure that you modify any denied Expense Reports in a timely
manner. If an Expense Report has been denied you must review, modify, and re-submit it before it can be reviewed for

approval.

This module will show you how to modify reports that have been denied.

To check
whether any
expense reports
have been
denied, begin by
clicking SFS
Applications
from the SFS
home page.

NOTE: Save
periodically as
SFS times out

after 20 minutes.

[ /& Employee-facing registry content - Microsoft

G

¢ Favorites | /& Employee-facing registry content

| 21 hitps://nysicsfs ny.gov/psp/SFS/EMPLOYEE/EMPL/ )

‘Welcome

STATEWIDE
FINANCIAL
SYSTEM

Enterprise Menu

#I 8FS Applications

% My Content

# Reporting Tools

- My Instant Messaging

- Change Wy Password
- My Personalizations
= My System Profile

er provided by New York State OG:

b=DEFAULT -

SFS Communications B @My Reports
Welcome to the Report Folder
Statewide Financial System (SFS) | | '"e22  M-BeR
Agency User Portal! NYGRO033  General
NYGLO363 NY_BOR

First time logging in? See the "BEFORE using the SFS"
section below for important steps and infoermation regarding
your password.

NY CSHBAL AE General
2013025890213
See the 2/7 issue of E ise C ion for information on:
2/13 FDR Preparation Workshop for FYE; Updated OSC Calendar
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01302082230 5

Report Manager

12/18/12, SFS SYSTEM ALERT: The SFS Program will be making
changes to the way file attachments are scanned before they are
saved to SFS Financials Production (PCAS) beginning today. These
changes may result in users receiving messages they have not seen
before. Please read the System Alert e-mail for full information.

11727112, SES SYSTEM ALERT: Agency users may experience
problems in the SFS Production Reporting (OBIEE) application
caused by an incompatibility issue between Adobe Acrobat and a
nsar's weh hrowser i a_Intamat Fynlorar 7 R ar 81 If won hava

€ Intemet | Protected Mode: On A v H100% ~
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Click SFS
Financials (either
location).

 Base Navigation Page - =

&) htps://perftest.sfs.ny.gov/psp/SFS/EMPLOVEE/EMPL/s/WEBLIB_PTPP_SC.HOMEPAGE FieldFormulaScript_AppHP7pt_fname=NY_PAPP ¢ v G [ 45| X Bing L~
—

| 1G]

<y Favorites ‘ & Base Navigation Page

STATEWIDE
FINANCIAL -
| SYSTEM i

=
= SFS Financials . .
- SFSReports ﬂj SFS Applications
i SFS Applications
- Change My Password
- My Personalizations = SFS Financials SES Reports
E SFS Financials E SFS OBEEE Reports

- My System Profile

Next, click
Employee Self-
Service.

i Favorites |§ Employee-facing registry content

Search:

[ Wy Favorites .S
[ Employee Self-Service

[ eProcurement

> Travel and Expenses
[ Warklist

> Tree Manager

> Reporting Tools

- PeopleTools

- My Personalizations
= My System Profile
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Click Employee
T&E Center.

ﬁ Employee Self-Service

[ Travel and Expenses
> Employee T&E Center

E My Wallet
E Review Pavments
[E Review Expense History

[~ My Personalizations
|~ My System Profile

ﬁ Travel and Expense:
Submiireview expense reports, cash advance requests, or fravel authorizations.

e

Employee T&E Center /

Employee Travel and Expense Self-Service Center
[ Review Payments

C Other Expense Functions

[ Expense Report

) Travel Authorization

Under Expense
Report click
Modify. This will
allow you to
check whether
expense reports
have been
denied and, if
they have been
denied, to
modify the
expense report
so that it can be
re-submitted for
approval.

ﬁ Employee T&E Center

Employee Travel and Expense Self-Service Canter

:_5 Review Payments
Review history of expense payments

[ Travel and Expenses
> Employee T&E Center
=) Review Expense History
= Review Pavments

Travel Authorization

- My Personalizations Create, modify, print, view or delete a Travel Authorization

- My System Profile = Create
= Modify
= Print

3 More.

Other Expense Functions

*You can view contents in My Wallet, create your own
template, or modify an existing template.

E View My Wallet
= Undste Profile

ﬁ Expense Report
Create, modify,#fint, view or delete an Expense Report
[=] Create

Page 3 of 10



You will be
directed to the
Expense Report
search page.

You can click the
minimize button
of the menu
pagelet to get a
better view of
your Expense
Reports.

You can use the
Search by drop
down menu to
indicate how you
want to search
for your expense
report (for
example, you
can search for it
by Report ID,
Employee name,
etc).

/[ Statewide Financial Syster. % { [ Base Navigation Page x )f [ Modify x B

E=Sioac]

€« ->C https://prifin.sfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION FieldFormula.iScript_ModifyExpense? TEMenu.Var=ADMIN&FolderPath=PORTAL_ROOT_OBJECT.CO_EMPLOYEE_SELF_SERVICE. (¥

fSzarcn

®

oy Favorites
I Employee Self-Service
> Travel and Expenses
~ Employee TAE Center
1 Review Payments
1> Other Expense Functions|
= Expense Report

1 Travel Authorization
> eProcurement

0 Travel and Expenses

> Workist

0 Tree Manager

> Reporting Tools

0 PeapleTools

|- 1y Personalizations

|- iy System Profile

Expense Report
Enter any information you have and click Search. Leave fields lank for a list of all values.

/
|/ Find an Existing Value Y ﬂ/:laaNewV}ﬂe il

Search by: |ReportiD [] beains wnml:l
Search | Advanced Search

Find an Existing Valus | Add a New Value

Home

Workist

Add to Favories | Signout

New Window |
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Once you have
entered the
relevant search
for your expense
report, you will
see a list of
expense reports
that have a
Report Status of
Pending.
Reports that are
pending require
further
modification
from you. There
are two reasons
why a report
would be
pending:

1. The expense
report has been
submitted back
to you for more
information or
editing of
existing
information

2. You saved an
expense report
to edit at a later
date, and did not
submit the
report to the
supervisor’s
worklist.

/[ Base Navigation Page % J [ View [

ol

€« > C httpsy//prifin.sfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION.FieldFormula.iScript_ViewExpense?TE.Menu.Var=ADMIN &PORTALPARAM_PTCNAV =EPTE_VIEWEXPENSE&EOPP.SCNode=E @, 77| =

s’s

Expense Report

Enter any information you have and click Search. Leave fields blank for a list of all values

{ Find an Existing Value

Home

Search by: [ReportID [-] begins with

Search | Advanced Search
Search Results

1ToI7 [}

Report ID Report Description Name EmplID  Report Status Creation Date
0000045458 Program meeting in Buffalo DOE, JOHN N01605598 Submitted 01/29/2013
0000045448 Program Meeting in Buffalo DOE, JOHN NO01605598 Submitted 01/24/2013
0000045340 Trip to Rochester DOE, JOHN N01605598 Pending 11/16/2012
0000035557 Participate in mtg for DFS  DOE, JOHN NO01605598 Pending 06/19/2012
0000031199 net due from paper voucher DOE, JOHN NO01605598 Rejected / 06/12/2012
0000016803 te Long Island DOE, JOHN NO01605598 Pending 05/18/2012
0000003124 Net due from EA 2012 DOE, JOHN N01605598 Paid 04/23/2012

| Worklist

Add to Favorites

New Window | Help

Sign out
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Click the report
you want to
modify.

/[ Statewide Financial Syster X

1 [ Base Navigation Page x / Mdify

®

0 My Favorites
|7 Employee Self-Service
b Travel and Expenses
© Employee T&E Center
> Review Payments
> Other Expense Functions|
= Expense Report

= Print

= View
> Travel Authorization
[0 eProcurement
0 Travel and Expenses
0 Workiist
o Tree Hanager

Expense Report
Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Val Add a New Value
Search by: [ReportiD beginswit |

Search | Advanced Search

Search Results

[ 133 [3]
Report Status Creation Datel

[ReportID  Rep.rt Description EmpiiD

[ Reporting Tools 0000045340 gy to Rochester DOE, JOHN NO1605538Fending 111162012
> PeopleTools 0000025557 Participate in mtg for DFS DOE, JOHN MNO1605598 Pending 06/19/2012
|= My Personalizations 000001680310 Long Island DOE, JOHN' M01605598 Pending 05/18/2012
|= My System Profile
Find an Existing Value | Add a New Value
Waiting for préfin.sfs.ny.gov.
Once you have /T Statewide Financial Systen % [ Base Navigationage % 7 [J Modiy -\ B

entered the
report you can
see that it has
been denied,
who denied it,
and why it was
denied.

You can click the
reason for denial
to view the
complete details
of the reasons
for denial. This
information will
be displayed in
red.

®

0 1y Favorites
|7 Employee Self Senice
b Travel and Expenses
= Employes T&E Canter
b Review Payments
b Other Expense Functions|
= Expense Report

- View
> Travel Authorization
> eProcurement

[ Travel and Expenses

> workiist

o Tree Manager

> Reporting Tools
> PeopleTaols

|- v Personalizations
|- uy System Profile

https.//prffin.sfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION.FieldFormula.iScript_ModifyExpense?TE.Menu.Va

Expense Report
Expense, Report Entry

User Defpfiits Report ID; UUHDMENV Aftachments (0
Denied By: SMITH, JANE Ensure receipts are attached

~ General Information

‘Description:|Trip to Rochester
Business | Routine Travel [+]

Comment: 4

Reterencer ||

Purpose:
Location: Not Applied
Post State:
[ out of state Official Station: Albany, NY Work Location | |
Travel Dates From To

=
From(HH:MI) 3:30AM To(HH:MI)

Normal Wark Hours

Accounting Defaults Apply Cash Advance(s

[ Overview |
Select| [*Expense Type *Expense Date| *Amount Spent|~Currency "Payment Type Billing Type |
[] | | Return To State Charges 061412012 3036[USD  [Travel Card Detail
[] | [ vehicle Rental ~l|osr1a12012 6284[UsD  [Travel Card Instate [=]|Datail
[ | | Fuelfor Traver [=]|o8rar2012 51.65[USD Travel Card |1 state [~][Detail
[ | | Fuelfor Traver [=]|o6r1a12012 43.85[UsD Travel Card | 1nstate [+]
[] | | Recpted Logging []|08r4r2012 96.00[USD  [Travel Card In State [+
— —t
[ | |[Retum To state Charges  [<]|0s13r2012 4064|usD  [Travel Card Instate [~
Retum To State Charges 0511412012 3035|usD  [Personal Funds DR
In State
Return To State Charges 06132012 -49.64[usD Personal Funds Detail
Nonbillable

DMIN&FolderPath=PORTAL_ROOT_OBJECT.CO_EMPLOYEE_SELF_SERVICE|vy| =

Worklist

Add to Favoriies ian out

New Window | Help  *
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Once you click
the reason for
denial you will
be directed to a
page where you
can see the
Name of the
approver, the
Action, what
Date and Time
the action was
undertaken, and
Comment
explaining why
the report was
denied.

Click Return to
go back to the
main Expense
Report page so
you can make
the appropriate
adjustments /
edits and, if
necessary, add
attachments to
your report.

/[ Statewide Financial Syster x

[ Base NavigationPage [} Modiiy

x \

e e o — ——

i

< € | @ httpsy/prifinsfsny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION.FieldFormula.iScript_ModifyExpense?TEMenu.Var=ADMIN&FolderPath=PORTAL_ROOT_OBJECT.CO_EMPLOYEE_SELF_SERVICE. 72| =

sfs

[E=aren

®

> Wy Favorites

[7 Employee Self-Senvice
[> Travel and Expenses
= Employes T&E Center
I Review Payments
[> Other Expense Functions|
< Expense Report

= View
> Travel Authorization
> ePracurement

> Travel and Expenses

o workiist

> Tree Manager

> Reporting Tools

> PeopleTools

|- by Persenalizations
|- bl Svstem Profile

javascriptisubmitAction_wind(documentwind, EX_ACTN_RICT_VW_EXCEPTIONS_PBS0;

View Approver c?éms

Name: Smith, Jane
Action:  Denied
DatelTime: 02/11/2013 12:24:51PH

Comment: Ensure receipts are attached

Home

Workist

Add to Favorites

Sign out

Hew Windaw | Help
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The adjustments
you have to
make to
resubmit the
Expense Report
will depend on
the reason for
denial. Some of
the most
common reasons
for denial
include:

+ Receipts are
not attached to
the expense
report

+ Travel dates
are not filled in
+ Normal work
hours are not
filled in

+ Mileage is not
specified

There could be
other reasons
for denial that
were not
mentioned here.

/' [ Statewide Financial Syster X

[ Base Navigation Page

x | [ Modify

x

- e« e - - — it

B8l

€ c

1 Wy Favorites
= Employee Self-Senice
b Travel and Expenses
< Employee T&E Center
- Revigw Payments
I Other Expense Functions|
~ Expense Report

I Travel Authorization
1> eProcurement
1 Travel and Expenses
- Warklist
1 Tree Manager
- Reparting Toals
1 PeopleTools
|- My Personalizations
| My Sstem Profile

javascriptsubmitAction_wind (document.wind, EX_ACTN_RICT_VW_EXCEPTIONS_PBSOY;

Expense Report

Expense Report Entry

Denied

=

“Description: Trip to Rachester

User Defaults

By: Smith, Jane

“Business | Rautine Travel [=]
Purpose:
status: Pending
Default  |NYROCHESTER Q
Location: Not Applied
Post State:

[Tout of state Official Station:

Travel Dates

Normal Wark H

jours

Report ID:

0000045340

Attachments (0}

Ensure receipte are attached

Comment: 4
Reference:
DOB Approval
Code
Last 027112013 By:  kravali
Updated:
Albany, NY Work Location
From M0 1o sl
From(HH:MI) 8:30A1 To(HHMI)  4:30PW

Accounting Defaults

2pply Cash Advance!

Wore Option [=] e
[Select] [-Expense Type *Expense Date] “Amount Spent|-Currency [*Payment Type “Billing Type
a8 Return To State Charges B 06/14/2012 30.36|USD | Travel Card In State |z|
[ | || vehicle Rental [+]|osr14r2012 63.84|USD Travel Card InState [+]
[ | | Fuel for Travel [=]|06r14r2012 51.65|USD Travel Gard In State
[ | |[Fuelfor Travel [=][os1142012 4385(USD [Travel Card In Stat
[ | |[RecptedLodging [=][os1142012 96.00[USD  [Travel Card In State =]
[ | |[Retum To State Charges  [<][0s112/2012 49.64|UsD  Travel Card In state [=]
Retum To State Charges 061142012 -3036[USD  [Personal Funds [
Refim Ta State Charnes 132012 4964{UsD  |Persanal Funds In State

Workiist

ittps://prifin.sfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION FieldFormula.iScript ModifyExpense?TE.Menu.Var=ADMIN&FolderPath=PORTAL_ROOT OBJECT.CO_EMPLOYEE SELF SERVICE. 77| =

Ao Favortes | Smou

MNew Window | Help =

Make changes in
your expense
report as
indicated by the
denial
comments.

To review how
to correctly
enter all the
fields in an
expense report,
see the
“Creating an
Expense Report
in SFS using a
Blank Report”
module.

An! Syster X

0 Page

x [ Modity x

Lo [ i

< C https://prfin.sfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION FieldFormula.iScript_ModifyExpense?TE.Menu.Var=ADMIN&FolderPath=PORTAL_ROOT_OBJECT.CO_EMPLOYEE_SELF_SERVICEI{y

sfs

Hors &
®

b 11y Favorites

[ Employee Selr-Senice

b Travel and Expenses

> Employee T&E Center
> Review Payments
I> Other Expense Funcions|
< Expense Report

> Travel Authorization
> eProcurement
b Travel and Expenses
> Worklist
[ Tree Manager
> Reporting Tools
b PeopleTaols
|- Wy Personalizstions
|-y System Profile

javascript:submitAction_win0(document wing, EX_ACTN_RICT_VW_EXCEPTIONS_PBSO')

Expense Report

Expense Report Entry

Denied

B

FDescription: Trip ta Rochester

“Business | Routine Travel

Purpose:

status: Pending
Default  NYROCHESTER
Location: Not Applied
Post State:

[Coutof state

User Defaults

By: Smith, Jane

B3]

<Y

Official Station:
Travel Dates

Normal Work Hours

Report ID:

0000045340

Ensure receipts are attached

Comment:
Reference:
DOB Approval
Code
Last 021112013
Updated:

Aloany, NY

i

i

rom 06113/201 [

rom(HKAN) [3:301

Atachments (0)

4
By:  kravali

Work Location

To 061472031

To(HH:M)

4:30PH

Accounting Defaults

Apoly Cash Advance(s)

More Options:

o

nize | Find | Vies
*Overview
Select] [*Expense Type “Expense Date | *Amount Spent|*Currency[*Payment Type “Biling Tyoe
[ | || Return To State Charges [+]| 061412012 2026\USD  [Travel Card In State [+]| Detail| FE]
[7] | || vehicle Rental [=]|0s11472012 63.84|USD Travel Card In State [+]| Detail | ]
[ | | Fuetfor Travel [=]|0s11472012 51.65|usD Travel Card inState [~]|Detail |+
[ | | Fuelfor Travel [=]|081142012 4385/USD Travel Card In State ]| Detail | F]
] | ||Recpted Lodging [=]| 0611412012 96.00|USD [ Travel Card InState [+]| Detail| ]
[ | || Retum To State Charges 061132012 4954|USD  [Travel Card In State [+]| Detail| =)
In State
Retum To State Charges 0611412012 -3036|USD  |Personal Funds Nongianis |22t
o In State
efiirn To State Charnes, 0RA32012 -49 84|USD Personal Funds. Detail
Nonbillagle | 2=

New Window | Help =
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Once you have
completed
making your
changes, click
Check For Errors.

/[ Statewide Financial Syster %

[ PeopleSoft 8 session expir % [ Modify

e—— o~

Y
* -—

=l

https://prffin.sfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION.FieldFormula.iScript_ModifyExpense?TE.Menu.Var=ADMIN&FolderPath=PORTAL ROOT_OBJECT.CO_EMPLOYEE SELF_SERVICE/ ¢

oy Favorites
[ Employee Self-Senvice
> Travel and Expenses
~ Employee TAE Center
1 Review Payments
1> Other Expense Functions|
= Expense Report
- Create
Modify
- Print

1 Travel Authorization
> eProcurement
0 Travel and Expenses
> Workist
0 Tree Manager
> Reporting Tools
0 PeapleTools
|- 1y Personalizations
|- iy System Profile

DESCHPULIE 1 1P 10 ROCNESTer

“Business | Routine Travel [=] Reference:
Purpos:
status: Pending D08 Approval
Last 02112013 By:  kravalij
Default MY ROCHESTER QU Updated:
Location: Not Applied
Post State:
[T out of State Official Station: Albany, NY Work Location
Travel Dates From 06132015 1o eraiE
Normal Work Hours From(HH:MI) [3:3041 To(HH:M)  [£:30PM
Accounting Defaults Apply Cash Advance(s)
Accounting Defaults Apply Cash Advance(s More Options 5] eo
omize | Find | View Al st ) 140 0f 10
*Overview
select| [“Expense Type pense Date| zAmount spent|-Currency|-Payment Type “Billing Type
[7] | | Return To State Charges 0611412012 30.36|UsD Travel Card In State
[ | |[Vehicle Rental 061412012 6384[UsD Travel Card In State [ |Detail | ]
[ | | Fuelfor Travel 061412012 51.65|usD Travel Card In State
[ | |[Fuetfor Travel 0611412012 4385[UsD Travel Card In State
[ | |[Recpted Logging 0611412012 96.00[usD Travel Card In State [ ||Detail | ]
[ | | Return To State Charges 0611312012 49.64|usD Travel Card In Stats
In State
Retum To State Charges 0611412012 -30.36(USD Personal Funds
In State
Retum To State Charges 0611312012 -49.64|UsD Personal Funds
Nonbillanle
[ || PDiem-Oumgt Meals [ 081137201255 51.00/[UsD Personal Funds [« In State §|
[] | |[PDiem-Gumgt Extra Dinner []| 061422012 [z 41.00/|usp Personal Funds

Copy Selected Delete Selected | New Expense [=] Add Check For Errors
Employee Expenses: 34734 USD Due Employee: 12.00 USD
Non-Reimbursable Expenses: 0.00 USD Due Vendor: 0.00 USD
Prepaid Expenses: 335.34 USD
Employee Credits: 0.00 USD
Vendor Credits: 0.00 USD
‘ e : = — —
If there are no s Sy [ PeoplesoRtasession sipi )/ () Moty N, || e e o —— — — lecon b
<« C' | @ nttpsy/prfinsfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION FieldFormula.iScript_ModifyExpense?TE.Menu.Var=ADMIN&FolderPath=PORTAL_ROOT_OBJECT.CO_EMPLOYEE SELF_SERVICE.I7g| =
Home ‘Workiist Add to Favorites

Expense Report,
click Save for
Later. If you do
not click Save
For Later, SFS
may not save the
most recent
changes you
made to the
Expense Report.

[ My Favorites
[~ Employee Self-Senice

b Travel and Expenses
< Employee T&E Center
b Review Payments

select| [-Expense Type

Expense Date| zAmount Spent|-Currency [‘Payment Type Billing Type

b Other Expense Functions|
© Expense Report

b Travel Authorization

0 eProcurement
b Travel and Expenses

B Return To State Charges 06/14/2012 30.36|USD | Travel Card In State E! Detail|[+-]
[] | |[Vehicle Rental 061412012 6384|USD  [Travel Gard In State [+]|Detail| =]
(] | [ Fuelfor Travet 0614/2012 5165[USD  [Travel Card In State [ ][ Datailf =]
=] Fuel for Travel 0611412012 43.85|USD Travel Card In State []| Detail| =]
[ | |[Recpted Lodging 061412012 96.00[USD  [Travel Gard In State []|Detail| =]
[ | |[Retum To State Charges  [~]|08113/2012 49.64|USD Travel Card In State [ | Datail | =]

0 workiist

In State

[ Tree Manager Return To State Charges 0614/2012 -30.36|USD Personal Funds Nongitabie el

[0 Reporting Tools

[F PeopleTaole Return To State Charges 08132012 4954[USD  |Personal Funds o ol |21

|- by System Profile
[ | |[Poiem-Ovmot Meals [+]| oar132012] 5 51.00/usD Personal Funds [ in State []|Detailf =]
[ | | Poiem-ovmgt Extra Dinner []| 0811412012 5 41.00/|usD Personal Funds  [|[ in State []|Detailf =]

Copy Selected Delete Selected

New Expense

& e

Employee Expenses: 347.34 USD Due Employee:
Non-Reimbursable Expenses: 0.00 USD Due Vendor:
Prepaid Expenses: 33534 USD

Employee Credits 000 USD

Vendor Credits: 0.00 USD

Cash Advances Applied: 0.00 USD

Check For Erors

12.00 USD
0.00 USD

/

Definition of Totals

Update Totals | ‘

Save FurLats! suomit

Submit For Approval

Expense Report Project Summary

First [4

Profile

DOE, JOHN
SMITH, JANE

HR Supervisor

Submitted
Denied

DatelTime
1116/2012 8:49:29AM
0211/2013 1224:51P1

Return to Expense Report
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Once you have
saved your
changes, click
Submit. This will
re-submit the
Expense Report
to your
supervisor’s
worklist.

/' [1) Statewide Financial Syster x

[} PeopleSoft 8 session expir. x | [ Modify

) o

TR ST B S . s, it

T ———— oo D S

«

®

Profile

DOE, JOHN

[ iy Favorites [ overview |
|- Employee Seif-Service
> Travel and Expensee Select] |Expense Type “Expense Date| 2Amount Spent -Payment Type Bilina Type
 Employee T&E Center
> Review Payments [T || Retum To State Charges [+ ]|0sr1arz012 30.36) Travel Carg Instate []|Detail| ]
> Other Expense Functions|
- ®
< Expence Report [71 | |[vehicle Rental [=]|0si14r2012 63.84|USD Travel Card In State [ |Detail | ]
_ Creat [ | |[Fuelfor Travel [=]|osrar2012 5168[usD Travel Card instate [+ ]|Detailf =]
[T | |[Fuel for Travel [=]|osrarza12 4385|UsD Travel Carg Instate []|Detail| =]
I- Travel Authorization [ | |[Recpted Logging [=]|osrar2012 96.00[usD Travel Card Instate [~ ||Detail| =]
> eProcurement
- Travel and Expenses [ | |[Retum To state Charges  [+]|0sr1312012 40.64[usD Travel Card instate [o]|Detailf =]
- Worklist T
> Tree fanager Retum To State Charges 061412012 -3036|usD Personal Funds
> Reporting Tools
igfacoetencots) Return To State Charges 0611312012 -4984fusD  |Personal Funos 1 State
|- by Sistemn Profile
[ | | Poiem-oumgt Meals [=][ 081320125y 51.00/|usD Personal Funds [~ [ In State [+][Detail|[F]
[ | |/PDiem-Oumgt Extra Dinner [<]|08r14r2012]5 41.00/|usD Personal Funds |~ [ In State [+][Detail|F]
Copy Selected Delete Selected New Expense [+] g Check For Errors
Employee Expenses: 34734 USD Due Employee: 12.00 USD
Non-Reimbursable Expenses: 0.00 USD Due Vendor: 0.00 USD
Prepaid Expenses: 33534 USD
Employee Credits: 0.00 USD
Vendor Credits: 0.00 USD
Cash Advances Applied: 0.00 USD
‘ / Definition of Totals Update Totals
Save For Later Suomit Expense Report Project Summary
~ Action History Submit For Approvt First 4] 1202 (V] L

Action Date/Time

https://prffin.sfs.ny.gov/psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION FieldFormula.iScript_ModifyExpense?TE Menu.Var=ADMIN&FolderPath=PORTAL_ROOT_OBJECT.CO_EMPLOYEE_SE

F_SERVICE.§%

I

Submitted 11/16/2012 8:49:29AM
HR Supervisor SMITH, JANE Denied 02112013 12:2451PM
Retum to Expense Report
} E— e ——
The Expense J (3 Satewide Fnancin Syser ¢ Y [3 PeaplesotBsmsion g % [ Moy A — ool O

Report Submit
Confirmation
page gives a
summary of the
expense report
you are
submitting. Click
OK.

Congratulations,
you have
successfully
completed
Modifying an
Expense Report
After it Has Been
Denied.

< C' | & ntps//

®
- Wy Favorites
[~ Employee Selr-Senice
b Travel and Expenses
< Employee T&E Genter
b Review Payments
[ Other Expense Functions|
= Expense Report

— View
© Travel Authorization

> eProcurement
> Travel and Expenses
> workist
> Tree Manager
> Reporting Tools
- PeopleTools
|- My Personalizations
|- v System Profile

Expense Report

Submit Confirmation
JOHN DOE

Employee Expenses:
Non-Reimbursable Expenses:
Prepaid Expense:
Employee Credits:
Vendor Credits:

Cash Advances Applied:

 cis
OK Cancel

3247.34 USD
0.00 USD
335.24 USD
0.00 USD
0.00 USD
0.00 USD

Report ID:

Workist

0000045340

Due Employes:
Due Vendor:
Definition of Totals

12.00 USD
000 USD

‘to submit, or click Cancel to return to the expense report without submitiing

sfs.ny.gov/ psp/fscm/EMPLOYEE/ERP/s/WEBLIB_TE_NAV.WEBLIB_FUNCTION FieldFormula.iScript_MadifyExpense? TE.Menu.Var=ADMIN&FolderPath=PORTAL_ROOT_OBJECT.CO_EMPLOYEE_SELF_SERVICE|T¢ | =

Add to Favortes ign out

New Window | Help
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